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S Energy Logger D550 0‘5’»@?’{;}. Dieser ,,Schnelleinstieg” ersetzt nicht die Technische Anderungen vorbehalten Sicherheitshinweise Weist auf eine unmittelbar dro- e Auch nach Abtrennen der Versorgungsspan- BestimmungsgemaBe Verwendung Das Gerat Das Gerat ist fUr den wettergeschitzten, orts- Digitale Einga G 5 RS485-Schnittstell
§ Schnelleinsti '%%. Betriebsanleitung. Bitte lesen und verstehen Wir weisen darauf hin, dass dieses Dokument Der ,Schnelleinstieg” stellt kein vollstandiges A hende Gefahr hin, die zu schwe- nung kénnen gefahrliche Spannungen im Das Gerét ist e ist ein Datensammler, als Basis lhres festen Einbau in Niederspannungsschaltanlagen igitale Eingange Gruppe chnitistelle
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« = Kommunikations-Einstellungen tiber Ethernet Haftungsausschluss kénnen sich &ndern. Bitte informieren Sie sich re MaBnahmen erfordern. Der ,,Schnelleinstieg” Weist auf eine moglicherweise ¢ Die in der Betriebsanleitung genannten e nicht fur den Einbau in Fahrzeuge bestimmt! e erfasst und speichert Zahlwerte und Prozess- e Die Einbaulage ist beliebig. Drehwahlschalter X1
= Software ,ecoExplorer go“-Einstellungen (siehe Link und QR-Code) Die Bea(ihtun_g der Informatlons?roduktg zZu unter www.weidmueller.de Uber die aktuelle er_1tha|t H_|nwe|se, die Sie zu Ihrer personhche"n A geféhrliche Situation hin, die zu Grt_anzwertfa nicht uberschre|ter_1, dies ist auch Der I%lnsatz des_Gerats in nicht 9rtsf_esten daten. e Eine Fremdbellftung ist nicht erforderlich.
den Geraten ist Voraussetzung flr den sicheren Version. Sicherheit und zur Vermeidung von Sachsché- schweren Verletzungen oder Tod bei der Priifung und der Inbetriebnahme zu Ausrustungen gilt als auBergewdhnliche Um-
Betrieb und um angegebene Leistungsmerk- den beachten mussen. WARNUNG! fiihren kann. beachten. weltbedingung und ist nur nach gesonderter Die erfassten Daten dienen der .
male und Produkteigenschaften zu erreichen. Entsorgung _ : : : ¢ Beachten Sie Sicherheits- und Warnhinwei- Vereinbarung zulassig. e Auswertung von Energieverbrauchen und 2 LEDs - Gerétestatus
Fur Personen-, Sach - oder Vermégensscha- Bitte beachten Sie nationale Bestimmungen! Verwendete Symbole: Weist auf eine moglicherweise se in den Dokumenten, die zu den Geraten e nicht fur den Einbau in Umgebungen mit Betriebsstunden. JETg i Ethernet-Schnittstelle
den, die durch Nichtachtung der Informations- Entsorgen Sie gegebenenfalls einzelne Teile, je : A gefahrliche Situation hin, die zu gehoren! schadlichen Olen, Sauren, Gasen, Dampfen, o Uberwachung von Schaltzustanden und / / / / /+
i tiberni ie Weidmii i isti 4 Dieses Symbol als Zusatz zu den leichten Verletzungen oder Sach- 4 i 5 i 4 i
0t pj produkte entstehen, ibernimmt die Weidmiller nach Beschaffenheit und existierende lander- A Sicherheitshinweisen deutet auf VORSICHT! o X . Stauben, Strahlungen, usw. bestimmt. Stérungen in Gebauden und Betrieben. R
e Interface GmbH & Co. KG keine Haftung. spezifische Vorschriften, z.B. als: aine elektrische Gefahr hin. schéden flhren kann. Qualifiziertes Personal miiller Enery Loager 0550 o .
N Sorgen Sie daflr, dass |hre Informations- e Elektroschrott - i i Um Personen- und Sachschéden zu vermeiden, Der einwandfreie und sichere Betrieb des g oo Batteriefach
_ produkte leserlich zuganglich sind. e Kunstoffe Dieses Symbol als Zusatz zu den MaBnahmen zur Sicherheit darf nur qualifiziertes Personal mit elektro- Gerits setzt sachgeméaBen Transport, sachge- A S
N g A“’,fi”:f“ o Metalle Slcherheltshlleels?nhdil,.ltet auf Beim Betrieb elektrischer Gerate stehen technischer Ausbildung am Gerét arbeiten mit méBe Lagerung, Aufstellung und Montage sowie Floir ooz hkhds ssma @A
Thlia Weiterfiihrende Dokumentationen finden Sie oder beauftragen Sie einen zertifizierten eine potenzielle Gefahr hin. zwangslaufig bestimmte Teile dieser Gerate un- Kenntnissen Bedienung und Instandhaltung voraus.
auf unserer Website www.weidmueller.de. Entsorgungsbetrieb mit der Verschrottung. (=  Dieses Symbol mit dem Wort ter gefahrlicher Spannung. Es kdnnen deshalb e der nationalen Unfallverhiitungsvorschriften
HINWEIS! beschreibt: schwere Korpervgrletzung oder Sachschaden e in Standards der Sicherheitstechnik
Urheberrechtsvermerk Relevante Gesetze, e Verfahren, die keine Verlet- auftreten, wenn nicht fachgerecht gehandelt e in Installation, Inbetriebnahme und Betrieb
http://wmar.eu/242552 © 2016 - Weidmiiller Interface GmbH & Co. angewendete Normen und Richtlinien zungsgefahren bergen. wird: _ . des Gerits.
KG - Detmold. Alle Rechte vorbehalten. Jede, Die von der Weidmiiller Interface GmbH & e Wichtige Informationen, Ver- * Vor Anschluss von Verbindungen das Gerat, Anschluss
W_eidmi,'lller Interface GmbH & Co. KG auch auszugsweise, Vervielfaltigung, Bearbei- Co. KG angewendeten Gesetze, Normen und fahren oder Handhabungen. am Schutzleiteranschluss, wenn vorhanden, o o Versgrgungsspannung
Klingenbergstrafe 16 tung, Verbreitung und sonstige Verwertung ist Richtlinien fiir das Geréat entnehmen Sie der erde"n. ) ) ) Digitale Eingénge Gruppe 3 Service Taste S2
D-32758 Detmold verboten. Konformitatserklarung. Sicherheitshinweise sind durch ein Warndreieck * Geféihrliche Spannungen kénnen in allen HINWEIS! Digitale Ausgange Temperaturmesseingang
495231 14-0 hervorgehoben und je nach Gefahrdungsgrad mit der Spannungsversorgung verbundenen Né&here Informationen zu Geréate-Funktionen, -Daten und -Montage finden Sie in der Betriebs-
+49 5231 14-292083 . . wie folgt dargestellt: Schaltungsteilen anstehen. anleitung
info@weidmueller.de We’dmu’ler % :

Versorgungsspannung anlegen PC-Anschlussvarianten Gerateadesse (RS485)

Sind mehrere Geréte lber die RS485-Schnitt-
stelle miteinander verbunden (z.B. in einer
Busstruktur, vgl. Schritt 9) , unterscheidet das
Mastergerét die integrierten Gerate anhand der
Geréateadresse. Daher bekommt jedes Gerat
eines Netzwerks eine andere Gerateadresse.

DIP-Schalter S1, LED-Geratestatus

DIP-Schalter S1

Je nach Platzierung des Energy Logger D550 in
einer Busstruktur, kann tber den DIP-Schalter
S1 der integrierte Bus-Abschlusswiderstand
aktiviert werden (vgl. Schritt 9).

Ethernet-Schnittstelle RS485-Schnittstelle

Die RS485-Schnittstelle am Gerat

Die Versorgungsspannung fiir das Gerét erfolgt
Uber eine 2-polige Steckklemme.

Die Hohe der Versorgungsspannung und der

Frequenz lhres Geréts entnehmen Sie dem
Typenschild.

Um alle Geratefunktionen des Geréts zu para-
metrieren, bendtigen Sie ein PC mit installierter
Netzanalyse-Software ,,ecoExplorer go*
(verfugbar unter: siehe Deckblatt).

Ethernet

Sachschaden durch Nicht-
beachtung der Anschluss-
bedingungen oder unzu-
lassige Uberspannungen

Die géangigsten PC-Anschlussvarianten zwischen 5.
Gerét und PC:

1 PG Ethernet
(gedrehtes Patch-Kabel)

Direktanschluss PC und Energy Logger D550 iber Ethernet.

Energy Logger
D550

(Gateway)

Energy Meter
D37

o

)
(@)
Ethernet
B
7
Y
[+
a

Energy Logger
D!
(Modbus-Slave)

Energy Meter
D37

i Netzwerkeinstellungen fiir das Ethernet-Netzwerk
(Modbus-Slave)

sind vom Netzwerkadministrator vorzunehmen
und entsprechend am Energy Logger D550 Uber
die Software ,,ecoExplorer go* einzustellen.

e Wird ein Slave-Gerat mit eingeschalte-
Werkseitig ist der Energy Logger D550 e ist als 2-poliger Steckkontakt ausgefihrt. tem Busabschluss ausgetauscht oder ist
auf die feste IP-Adresse 10.10.10.200 e kommuniziert tGber Modbus-RTU-Protokoll. spannungslos, kann die Busstruktur instabil
(Subnetzmaske 255.0.0.0, DHCP = deak-| werden.

tiviert) eingestellt. Das Gerat lasst sich benutzerfreundlich in der e Gerate ohne Busabschluss kénnen ohne
Die dynamische IP-Adresse konfigurieren Software ,,ecoExplorer go“ konfigurieren. Rlckwirkungen auf die Busstruktur ausge-

HINWEIS!

0
Modbus-Slave)
Anschluss des Energy Logger D550
mit Gateway-Funktion an den PC RS485

Energy Meter
D650
Modbus-Slave)
Energy Logger Uber Ethemet.
D550 RS485

. . Ethernet
In dieser Anschlussvariante kann der

Energy Meter
D650
(Modbus-Slave)

VORSICHT!

Durch Nichtbeachtung der Anschluss-
bedingungen oder Uberschreiten des zu-

Abb. Anschluss der Versorgungs- Abb. Anschluss Uber das Modbus-Protokoll werden Daten mit

Energy Analyser
D550
spannung Uber ein externes Netzteil. der Versorgungsspannung.

Hilfe der Modbus-Adressliste gedndert und Modbus-Master Die Gerateadresse des Energy Logger D550 LED-Geréatestatus SECHEES Sie tiber eine Ethernet-Direktverbindun tauscht werden.
lassigen Spannungsbereichs kann Ihr Gerat abgerufen. Die Modbus-Adressliste finden Sie * Energy Logger D550 Anfragen (z.B. von der Anschluss des Energy Logger D550 konfigurieren Sie tiber 2 Drehwahlschalter 2 LED-Leuchten unterhalb der RS485-Schnitt- | e ; : 9 RS485-Busstrukt
beschéadigt oder zerstért werden. J Software) an ein Modbus-Slave-Gerat weiter- e e erdy 299¢! 9 E0% L 408 mit der Software (vgl. Schritt 14, 15 und usstruktur

unter www.weidmueller.de. 2 als Moalbus-Slave-Gerét. X10 X1

stelle zeigen den Geratestatus des Gerats:
B B Beide LEDs leuchten. Das Gerat befindet

- - . Energy Logger
Bevor Sie das Gerét an die Versorgungs- D550

spannung anlegen beachten Sie bitte:

leiten.
e Energy Logger D550 keine Modbus-Slave-

16). ¢ In einer RS485-Busstruktur (Linie) verbinden
Sie alle Gerate nach dem Master-Slave-Prinzip.

In dieser Anschlussvariante

Um das Geréat Uber die Software zu paramet- Ethernet Ethernet i oo e erfolgt die Kommunikation zum Energy Logger o ) « Ein Segment einer RS485-Busstruktur kann bis
- witcl er N h tart 3 _ -
* Spannung und Frequenz miissen den \ rieren, verbinden Sie Ihren PC (iber die serielle *~ Gerate selbststandig abfragen! D550 iber Ethernet oder den Modbus-Master. sich im Startvorgang Esr;?rggs\/viirtt::'gdung ngﬁeltzwl'(\:;:?r; & DHCP-Server konfigurie- 2u 32 Teilnehmer/Gerite beinhalten.
Trennvorrichtung Angaben des 'ijp_enschllds _entsPrec_hen' Schnittstelle RS485 oder liber Ethernet mit dem Anschluss des Energy Logger D550 iiber Ethernet und einen Switch. RS485-Modus: e kann der Energy Logger D550 keine Ethernet- | Nach 15 Sekunden ist der Startvorgang ren Sie die Netzwerkadresse des Gerits tber e Am Anfang und Ende einer Bustruktur termi-
Trennvorrichtung Sich Grenzwerte, wie in der Betriebsanleitung Gerat. : Abfragen an weitere Modbus-Slave-Gerate abgeschlossen. Die rote LED erlischt, die : ¢ nieren Sie das Kabel mit Abschlusswiderstan-
s icherung beschrieben, einhalten! Energy Logger D550 als Gateway, Adresse 3 = 1 iibermitteln! S LED louchtet und zeiat . Gerdit & Modbus oder tiber die Software. den (120 ©, 0,25 W). Das Gerat enthalt einen Abb.: Platzierung mittig in einer Busstruktur;
L ‘chering L ¢ In der Geb&iude-Installation die Versor- (Die Adresse konfigurieren Sie Uiber die Software grune euchtet und zeigt ,erat Im e . - Terminierung tber DIP-Schalter S1 deaktiviert (OFF).
3 9 . - . « R
N N . f . ecoExplorer go%) e Der Einstellbereich liegt zwischen 1 und 99. Betrieb*. X BootP Abschlusswiderstand der Uber DIP-Schalter S1
gungsspannung mit einem UL gelisteten ? P 907 RS485-Modus: e Die Gerateadresse 00 ist reserviert! Nicht fiir H22 e ; - - aktiviert werden kann.
Leitungsschutzschalter/einer Sicherung Energy L D550 als Sl Ad 3-0 : IStr : B Geritefehl Leuch ine Verbi Link ¢ erlaubt die automatische Einbindung des o Rai . ) )
- gy Logger als Slave, Adresse die Modbus-Kommunikation vergeben! eratefehler. euchtet, wenn eine Verbindung (Link) de Bei mehr als 32 Teilnehmern setzen Sie Repea
(6 A, Char. B) sichern! Anschluss des Energy Logger D550 h — [ . 9 Gelb Geréts in ein bestehendes Netzwerk. - . ;
Verletzungsgefahr durch y . : fiatedo (Die Adresse konfigurieren Sie Uiber die Software o Die Geriteadresse 99 erreichen Sie, indem besteht. ) . ter (Leistungsverstéarker) ein, um Bussegmente
elektrische Spannung! e Die Trennvorrichtung Uber ein Energy Analyser D550 afs Exol « ! ! e, 1 B B Leuchten nach dem Startvorgang beide — - e hat nicht den Funktionsumfang von DHCP. >
WARNUNG! P g: fiir den Nut leicht ohb. di Gateway. »ecoExplorer go®). Sie X10 = 9 und X1 = 9 einstellen (héchster LED terhi de die Inftialisi Griin Leuchtet unregelmaBig, wenn eine zu verbinden.
) - furcen Nuizer ‘eicht erreichbar und in Einstellwert) s weiterhin, wurde die Initialisierungs- Netzwerkaktivitét vorliegt. DHCP-Mod o An Gerdten mit eingeschaltetem Abschlusswi-
Schwere Kérperverletzungen oder Tod kénnen der Ndhe des Gerits anbringen. ) i phase unterbrochen. Uber die Software -Wodus . derstand muss Spannung anliegen.
erfolgen, durch: - fiir das jeweilige Gerit kennzeichnen. 4. Sachschaden durch falsche Netzwerkeinstellungen Beispiel Werkseinstellung ist ein Geréte-Update (Firmware) durchzu- DHCP integriert das Energy Logger DSS0 in « Empfehlung: Installieren Sie den Master ans
e Beriihren von blanken oder abisolierten ¢ Fiir den Neutralleiter eine Sicherung vor- VORSICHT! Gerateadresse 13 Gerateadresse 1 fuhren. Innerhalb eines Ethernet-Netzwerks besitzt jedes ein bestehendes Netzwerk mit DHCP-Server Ende eines I;_Bussegments Abb.: Platzierung am Ende einer Busstruktur;
Adern, die unter Spannung stehen. sehen, wenn der Neutralleiteranschluss Gerét eine eindeutige TCP/IP-Adresse, die manu- automatisch. Beim Start bezieht das Gerét vom « Wird das Master-Gerat mit ei haltet Terminierung tiber DIP-Schalter S1 aktiviert (ON, 120 Q).
o Beruh;’ungsgeféhrliche Eingéinge des Gerits der Quelle nicht geerdet ist. Anschluss des Energy Logger D550 Falsche Netzwerkeinstellungen kénnen Stérungen im IT-Netzwerk verursachen! 901 901 901 901 ell eingestellt oder vom DHCP-Server vergeben DHCP-Server die IP-Adresse, die Netzmaske Ird das Master-aerat mit eingeschaltetem
. A p o aber Schnittstellerwander Informieren Sie sich bei Inrem Netzwerkadministrator {iber die Netzwerkeinstellungen fiir lhr 8@)3) [Ea3 S3) [8@3 wird. und das Gateway. Abschlusswiderstand ausgetauscht, ist die
Vor Arbeitsbeginn lhr Geréat spannungsfrei Geri 7 2 7 2 7/ 7 7/ 7 Busstruktur auBer Betrieb
o erat. 05 05 °5 05 :
schalten! Spannungsfreiheit priifen!

Gruppe 1 Gruppe 2

Baudrate

Externe
Hilfsspannung 24V DC

Digitale Ein- und Ausgénge

S0-Impulseingang/S0-Impulsgeber Temperaturmesseingang

Abb. Darstellung Busstruktur Konfigurieren Sie flr Geréate in einer RS485- HINWEIS! Energy Logger D550 Digitale Ausgénge 242[?:—.205 Jeder digitale Eingang des Geréts ist fUr den H”fssp'jﬁfurﬁz 24V DC Der Temperaturmesseingang am Gerat ist
Busstruktur eine gemeinsame Baudrate. Die digitalen Ein- und Ausgange des Digitale Eingange 1-5 - Das Gerat besitzt 3 digitale Ausgange, die eine 4 - 2 § power Externe 24V Anschluss eines S0-Impulsgebers ausgelegt. fir Temperaturfihler mit einem Widerstands-
Energy Logger D550 konfigurieren Sie gemeinsame Masse nutzen: CE / / / / / ST é § A sl Hilfsspannung  AC/DC Energy Logger D550 - + bereich von 400 Q bis 4 kQ bemessen. Die
T Die Baudrate flir den Energy Logger D550 kon- benutzerfreundlich in der Software. a3V + e LEDs zeigen den Zustand der Ausgénge. e mn  mamnn  sma s A hy - Sie bendtigen eine externe Hilfsspannung mit Digitale Eingéinge 1-5 Gesamtblirde (Fuhler + Leitung) von 4 kQ2 nicht Beispiel.: L 25
\/ \/ figurieren Sie Uber Software oder die Adresse ﬂ%_/ Leuchtet die LED (rot), ist der Ausgang aktiv ge- E_“?"QY Logger D550 einer Ausgangsspannung im Bereich 20 .. 27V L& | Uberscheiten! 3-Leiteranschluss PT100 26
. o o 002 der Modbus-Adressliste. 123456 7e o0t = N Digital | S5 setzt - unabhéngig von einem weiterfiinrenden Digitale Ausgénge 1-3 DC und einen Widerstand mit 1,3kOhm/1W. Qe 57
ave ave ave Digitale Eingsnge /1] ﬁ-} /] %9 B3 Anschluss an diesem Ausgang. Digital Outputs 1-3 ﬂ—[ﬁ“ L 5] Das Gerét ermittelt einmal pro Sekunde den
Adresse 002 Baudrat Das Gerat besitzt 15 digitale Eingénge. i - a0V e Der digitale Ausgang 1 ist als Temperatur- Das S0-Steckmodul P Digital Temperaturmesswert. Den Sensortyp und den o o5
T A4 A4 Einstellung audrate Die digitalen Eingénge sind in 3 Gruppen mit je 5 Weidmiiller e —— A B _ Uiberwachung konfigurierbar. Er wird iber den Abb. Anschluss — [21] (optional erhéltlich): >" : ZAN Input 5 Temperatur-Offset konfigurieren Sie mit der Beispiel.: %
Slave Slave Slave Eingéngen gegliedert: Digral| S4 Temperaturmesseingang mit einem Vergleicher || Digitarimpuisausasdnge 4 Digital e erméglicht einen einfachen und schnellen Software oder {iber Modbus. 2-Leiteranschiuss PT1000
0 9.6 kbps * Jeweils 5 Eingénge haben eine gemeinsame . ) . g e >|’ : ZAN Input 4 geschaltet. 4Td Dig P gang \ S DC Anschluss von SO-Impulsgebern. aw X (verlangt zusétzliche Bricke) 20
_ _ 1 19.2 Kbos Masse. / / / / / (S é 3 A Sy — 22| e ist fiir eine Gruppe von 5 Eingdngen mit ﬂ%{ i
. Speisung notwendig / power supply necessary p . L >IN 3.9V . . . ) N . . . R Digital Weidmiiller 35 Energy Logger D550 7 a k
 LEDs zeigen den Zustand der Eingange. 51617181920 21222324 252627 S2 aK X Die digitalen Ausgénge: X integrierten Widerstanden. 7 N Input 4 Beispiel.: 25
T Busabschiub eingeschaltet / bus terminator on 2 38.4 kbps Leuchtet die LED (griin), liegt an diesem Ein- ﬂ%_; i e sind tiber Modbus und die Wochenschaltuhr = HINWEIS! =1 D 1,3KAW : ) . a0 2_] eiteranschluss KTY83 26
3 57.6 kbps gang ein Signal an. >V : VAN Input 3 schaltbar. e Verwenden Sie die digitalen Ausginge Y\ Ej Digital DC e GV / [[[] euil” é 2 (verlangt zusétzliche Briicke) 27
- ¢ Ein Eingangssignal liegt an (Signal ,,1%), wenn e kdnnen Ergebnisse von Vergleichern ausgeben. als Impulsausgange, darf die Rest- Output 2 ﬂ—%{ LOTERH _NRBHM 2822
4 1152 kbps (Werkseinstellung) an einem digitalen Eingang mindestens eine w38V * bendtigen eine externe Hilfsspannung. welligkeit der externen Hilfsspannung — @_[N_ >|4 : N ra o
Uber die Modbus-Ad 004 Konfiauri Spannung von 18 V anliegt (typisch 4 mA bei Anschlussbeispiel ,, Digitale Eingénge der P12 ——¢ * sind als Impulsausgénge nutzbar. (DC) maximal 5% betragen. — | * > Achten Sie bei einem Anschluss des Sensors
o erd. |eA o hlléls_ Stressgt .tog_lg;ms(:ren " 24V). Gruppen 1 und 2 >|7 = & Digital|  S2 e schalten Gleich- und Wechselstromlasten. « Digitale Ausginge sind nicht kurz- - a0V KTY83/84_auf korrekte Polaritat! S_chlleBen S_le
1o gle Anzan cer SIappbils it L = Stoppol e Ist die Eingangsspannung <5 V DC liegt kein e e sind nicht kurzschlussfest. schlussfest! RZ 3 Dlfg)iel %_%{ den negativen Anschluss (Kennzeichnung mit
(Werkseinstellung) und 1 = 2 Stoppbits. : : ; w HINWEIS! Output 3 = schwarzem Ring) an Klemme 25 an!
- o . ! . Eingangssignal an (Signal ,,0%). =] Abb.: SO-Steckmodul Digital
Datenbits (8) und Paritét (keine) sind voreinge- Fir einen fehlerfreien Betrieb des a3 24 8 eckmoau . AWAN Input 2
stellt Gerits: — P zum Anschluss von ’
. ‘e:?ez'egen Sie ab einer Lange von : VAN i S DC-Anschlussbeispiel von zwei Relais an S0-Impulsgebern a2
npu -, i .
. C-é(; ;2 r?ttégessic;h;r:tsoll_f:grége?rber die digitalen Ausgénge >| = Z;:l—%?g% o Abb.: Leiteranschluss PT1000
= 7 Input 1 Impuls-
sorgungsspannung fir die digitalen Anschlussbeispiel der externen Schaltkontakte e geber
Elngénge (20...30 V DC). S1 bis S5 an den digitalen Eingéngen 1 bis 5.

Die wichtigsten Technische Daten PC-Direktverbindung des Energy Logger D550 iiber Ethernet (Windows 7) Software ,,ecoExplorer go“ Einstellungen fiir die PC-Direktverbindung tiber Ethernet IP-Konfiguration des Energy Logger D550 (,,ecoExplorer go*) iiber

. . . . . - L . . PC-Direktverbindun
Versorgungsspannung Digitale Ausgénge Eine géngige Variante den Energy Logger D550 in 9. Klicken Sie auf die Schaltflache Egercnaten von nenaiproiial Verion  (CP/Pv) Abb. Installieren Sie die Software ,,ecoExplorer go“ auf 6. Wahlen Sie in der Auswahlliste ,,Verbin- 9
Installations 3 digitale Ausgange, Halbleiterrelais, nicht kurzschlussfest. Ihr PC-Netzwerk zu integrieren ist die Direktver- »Eigenschaften*. Hgenen MS-Windows 7 - Ihrem Computer und fahren Sie folgendermaBen dungstyp“ > ,Ethernet” und geben im Feld (C? HINWEIS!
Uberspannungskategorie | 200V CAT ! Betriebsspannung 20V -30VDC bindung Gber die Ethernet-Schnittstelle. 10. Nach Eingabe der Administrator-Daten e e e Fenster fort: S — LAdresse“ die IP-Adresse |hres Geréts ein Um den Energy Logger D550 in ein Netz-
Absicherung der Sicheruna: (SELV oder PELV-Versorgung) HINWEIS! erscheint das Fenster , Eigenschaften von et Eigenschaften von = s (Feste IP-Adresse 10.10.10.200) und im werk mit DHCP-Server und automatischer
E/éeircsrggjunn%swannung 6A, ChaE'B (nach UL/IEC) Schaltspannung max. 60 V DC < Da der Energy Logger D550 mit einer LAN-Verbindung*. e /nlerﬁewroz‘oko// Neues Projekt erstellen: Feld , Geréteadresse” den Wert der Drehwahl- Vergabe von IP-Adresse, Subnetzmas-
° AC 20 V - 250 V (45..65 Hz) od Schaltstrom max. 50 mAeff DO festen IP-Adresse ausgeliefert wird und _ S e Version 4 1. Wahlen Sie in der Menlileiste ,,Datei* > schalter des Energy Logger D550 (in diesem ke und Gateway zu integrieren, &ndern
Nennbereich A a0\ Gon, 4505 Ha) oder Impulsausgang max. 20 Hz um ihn in Thr Firmennetzwerk/lhren PC — Abb. otttz (TCP/IPv4)“ ,Neues Projekt“. Fiir vorhandene Fall , 7 vgl. Schritt 7). Sie die IP-Konfiguration von ,,Fester
Leistungsaufnahme max. 4 VA /2 W (Energie-lmpulse) : zu integrieren, bendtigen Sie fir die Abb. MS-Windows 7 - Fenster ,Netzwerk- und I I/{I__/S-l;l//ndows 7" Projekte wahlen Sie Ihr Projekt unter e 7. Klicken Sie auf die Schaltflache IP-Adresse* (Standardeinstellung) auf
. . ’ . Vetbindung herstellen Gber: i : = “ B “ “ -
Impulsausgang agghﬁzg\ggﬁggss-gégg folgenden Schritte Administratorrechte! Freigabecenter” & ASIX AXGET72B USE2.0t Fast Ehemet Adapter ;/-75 e haft Bevrmter DS Server »Datei” >, Projekt offnen' ’ ) ,,Vgrbmdgngstest v . »nDHCP-Modus®. Dazu stellen Sie zuerst
' Feste IP-Ad Ihres E L D550 7. Klicken Sie in der Rubrik Internet auf e S 2. Das Fenster ,Neues Projekt” erscheint. 8. Bei positivem Verbindungstest erscheint das eine ,,PC-Direktverbindung mit Energy
Digitale Eingan es i '-t' resstse d reds . n:rﬂy ogger ’ LAN-Verbinduna* Dl Yabindong vonvrdet Fndo Borerts: LAN-Verbindung (grtlientnBeendn e 3. Klicken Sie unter Schritt 1 ,,Projekt wédhlen* e |l e | Gaci Tt Fenster ,,Geréteinformation anzeigen® mit Logger D550 iiber Ethernet“ her und
; ;Sf;i;’it;e 'Eir%anz, R Y Temperaturmesseingang, 1 Eingang (3-Drahtmessung) (Werkseitige Standardeinstellung) 8. Das Fer?ster ;t agu-s von LAN-Verbinduna® — die Schaltflache , Weiter”. der Seriennummer, Hardwarerevision und konfigurieren den ,,DHCP-Modus*!
. 20V -30VDGC Updatezeit 1 Sekunde IP-Adresse 10.10.10.200 " erscheint. g B et = 4. Wiahlen Sie unter Schritt 2, Projektpfad® den: s & heint im Fenster der Schritt Firmwareversion. e
etriebsspannung 2 . - : - i “ . Es erscheint im Fenster der Schri Nachdem Sie den Energy Logger D550 tiber e
(SELV oder PELV-Versorgung) AnschlieBbare Fiihl PT100, PT1000, KTY83, KTY84 = E/n Tsbart g Tosiceshren. ~Projektname*. . s ——— - gy Logg : ; e .
Engangesignal iegtan | > 16V DG G:er:bmzza der Subnetmaske 255.0.0.0 T == Abb. B 12. Wahien Sie die Option, Folgends IP-Adresss - Projektpfad ,Verbindung konfigurieren®. Gerateinformationen anzeigen Ethernet mit Ihrem PC verbunden (vgl. Schritt 15) 3. Das Fenster ,Konfiguration [Gerat x]“ erscheint
(Signal , 1) (typisch 4 mA bei 24 V) (Fuhler u. Leitung) max. 4kQ DHCP deaktiviert [ en | MS-Windows 7 - e e " verwenden* und vergeben Sie die feste IP- 5. Klicken Sie auf die Schaltflache ,Fertig*. J BB <iormmer 14000447 und in der Software ,ecoExplorer go* eingebun- in der rechten Halfte des Arbeitsbereichs.
Ei ignal liegt nich p—— i i i ekt i Iy oosr 5 . = L :
a:]”g?;ﬁzf'_%l? legtnicht| 5 v pc IP-Adresse Ihres PCs fiir die Verbindung mit e o . ||renster T T —— Adresse und Subnetzmaske. Bitte beachten 6. Im Arbeitsbereich erichelnt Ihr Projekt links - Hordworercvicians 2 denhaben: '
- K ot Kottt ket ||| OMALUS VON ot ez N . . . im Fenster , Projekte”. . — G e T 1. Offnen Sie mit einem rechten Mausklick das
Impulseingang (S0), 05 Ha HINWEIS! dem Energy Logger D550 einstellen: ederious st | LAN-Verbinauna™ Sie, dass sich die IP-Adresse des PCs im == -] rmiserEom = Kontextmendi lhres Gerats:
max. Zahlfrequenz Weitere Technische Daten finden Sie in 1. Driicken sie die Windows-Taste. o os11s55 ung — 4. Zahlenblock von der festen IP-Adresse N Gerit in das Projekt einfiigen: e Im Fenster ,Projekte” > lh.r Projekt* >
Imoulsel ) nach DIN EN 62053-31:1998 der Betriebsanleitung zum Gerat. 2. Das ,Startmenii“ erscheint. i e Lot ] [evem des Gerits unterscheiden muss (siehe eues Gerat In das Frojext einfugen: - S e o
mpulseingang (IEC 62053-31:1998 Class B) - o . . ' 1. Wahlen Sie in der Mentileiste e L= »Geréte” > ,Nach Gerétetyp” >
U das Gerat nach DIN EN 6505531 (50) 20 betrelb 3. Klicken Sie im rechten Mentufeld auf . Abbildung oben)! Dater* ~ Neue Datei® T : Energy Logger D550 >, Gerdit x*
m das Gerat nac! - Zu betreiben, “ H R H H H H i A “* ” 5 . R 3 ” ” .
einen Widerstand (1,3 k/1 W) parallel zum Eingang »Systemsteuer ung-. st _ . Olf'ftn en Stle Tltke||r|1 (\e/m Dopaelklclc::k/l?auf4 d 13. Kicken Sie auf die Schaltfldche , OK™ 2. Das Fenster ,Neue Datei“ erscheint. e 9. Klicken Sie auf die Schaltflache ,,OK*. 2. Klicken Sie im Kontextmen( auf den
anschlieBen. 4. Das Fenster ,Einstellungen des Computers cemat — B erotoron ninternetprotokoll Version 4 (T vd) das ) 3. Wihlen Sie unter Schritt 1 . Dateityp wéhlen® Blsssqueas sl 10. Beenden Sie den Schritt ,Neues Gerét Mentieintrag , Konfiguration®.
anpassen*” erscheint. O Fenster , Eigenschaften von Internetprotokoll Der Energy Logger D550 kann nun lber die auf T A ” p yp ) in das Projekt einfiigen® I”Tllit Klick auf die 7
5. Klicken Sie auf ,Netzwerk- und Freigabe- Version 4 (TCP/IPv4)~. dem PC installierte Software konfiguriert werden! in der Kategorie , Datensammler” den , Datei- . "
center” @ [ typen“ ,Energy Logger D550 Schaltflache , Fertig
: . 4. Klicken Sie auf die Schaltflache , Weiter”. 11. Konfigurieren Sie Ihr Gerét
6. Das Fenster ,Netzwerk- und Freigabecenter® ” v vgl. die nichsten Schritte b
erscheint. (B [ (| ) (vgl. )- o
PC-Verbindung des Energy Logger D550 {iber Energy Analyser D550 als Gateway
4. Wabhlen Sie im Fenster ,,Konfiguration“ 1. Konfigurieren Sie lhr Energy Analyser Software ,,ecoExplorer go“ Energy Analyser D550 in das Projekt einfiligen: 5. Es erscheint im Fenster der Schritt 8. Bei positivem Verbindungstest erscheint Energy Logger D550 in das Projekt einfiigen: 8. Wabhlen Sie unter Schritt 1 ,,Dateityp wéh- (? HINWEIS!
unter Meni ,,IP-Konfiguration® in der Aus- D550 Uber Ethernet-Kabel an lhrem PC als Installieren Sie die Software auf lhrem Compu- 1. Wahlen Sie in der MenUleiste ,Datei” > ,Verbindung konfigurieren®. das Fenster ,,Geréteinformation anzeigen® 1. Klicken Sie im Projektefenster auf das len“ in der Kategorie ,,Datensammler* den Bitte beachten Sie, dass die Gerateadres- ‘
wabhlliste ,,DHCP Modus*“ > DHCP. +DHCP-Client” (Geréate IP-Adresse wird ter und fahren Sie folgendermaBen fort: »Neue Datei”. mit der Seriennummer, Hardwarerevision Plus-Symbol vor dem Verzeichnis ,,Geréte“. Dateitypen ,,Energy Logger D550*. sen des Masters (Energy Analyser D550) ;e":”"“m"'ff :4““'“442
5. Beenden Sie den Vorgang mit einem Klick automatisch vergeben, siehe Betriebsanlei- 1. Offnen Sie die Software auf Ihrem PC. 2. Das Fenster ,Neue Datei” erscheint. == - - und Firmwareversion. 2. Klicken Sie im Verzeichnis , Gerdte” auf das Plus- 9. Klicken Sie auf die Schaltflache ,, Weiter”. und des Slaves (Energy Logger D550) Frmmarcersion: 148
auf die Schaltflache , Ubertragen®. tung und Schnelleinstieg zum Gerat). 2. Wahlen Sie in der Mentileiste ,Datei” > e Bt pp— v ) Symbol vor dem Unterverzeichnis ,,Nach Gerétetyp*. 10. Es erscheint im Fenster der Schritt voneinander abweichen! Die Geritead-
2. Verbinden Sie Ihren Energy Logger D550 . Neues Projekt“. Fiir vorhandene Projekte exvsor — 3. Es erscheint das zuvor installierte Energy Analyser »Verbindung konfigurieren*. resse des Masters (Geréte-ID des Energy ]
Ihr Energy Logger D550 ist nun fur die automa- Uber die RS485-Schnittstelle mit dem wahlen Sie |hr Projekt unter ,,Datei” > Proges [t = ::s:wm] @ oo 05 D550. e ec I — Analyser D550) konfigurieren Sie im
tische Einbindung in ein Netzwerk mit DHCP- Energy Analyser D550. ~Projekt &ffnen*. Qe - 4. Klicken Sie mit der rechten Maustaste auf SRR veriming bontun Fenster ,,Konfiguration“ > Menti ,, Serielle 14. Klicken Sie auf die Schaltfliche ., OK*
Server vorbereitet. 3. Das Fenster ,Neues Projekt“ erscheint. . das Unterverzeichnis ,Nach Gerétetyp“. - MR Schnittstelle® in der Software. 15 Beenden Sie den Sohritt Eneray Logder
o HINWESS! 4. Klicken Sie unter Schritt 1 ,,Projekt wéhlen* 5. Wahlen Sie im Kontextmenii den Meneintrag ,,Neu*. B = " D550 in das Projekt einfi]’éen“ r%}llt Kl%cl;( auf
y die Schaltflache , Weiter*”. = 6. Klicken Sie im Untermeni auf den MenUeintrag P . . . s . " L
Um den Energy Logger D550 in ein 5. Wahlen Sie unter Schritt 2 , Projektpfad®  Anderes* - Cemmeae] — 12. KI|cke_n Sie auf dIS Schaltflache dl_e Schaltfliche , Fertig*. .
Netzwerk mit DHCP-Server und auto- den: ” 7. Das Fenster ,Neue Datei“ erscheint. Cerneatrese »Verbindungstest*. _ 16. Sie kénnen Ihr Gerét nun tber die Software
matischer Vergabe von IP-Adresse, Sub- - Projektname*. e 9. Klicken Sie auf die Schaltflache ,,OK*. - ;Nt“:“m: ””:; 13. Bei positivem VerPln_dungste_st ersch(_emt . konfigurieren.
netzmaske und Gateway zu integrieren, 7 Projektpfad* ‘ 10. Beenden Sie den Schritt ,,Neues Gerét in et ..~ Tty da_lts dFen;te_r ,,Geratelnfo;madt/on anzeigen HINWEIS!
5 ie die IP- i i . . . . . i infiigen® mit Kl ; schvite Dateiyp wablen © Modua > mit der Seriennummer, Hardwarerevision T : )
andern Sie die IP Konflguratllon von ,,Fes 6. Klicken Sie auf die Schaltflache , Fertig*. e —— das Pro;uekt emfuggn mit Klick auf die BATEs e Ry =— - © Modbus RTU Ethemet gaapset) und Firmwareversion Um Datenverlust zu vermeiden,
ter IP-Adresse* (Standardeinstellung) : : ; ; — Lo Jrowem 0 Schaltflache ,Fertig” 6 —— : i i A
P 7. Im Arbeitsbereich erscheint Ihr Projekt s T e e [ i Q it | i vebndrgaes. || speichern Sie Ihre Anderungen der
auf ,DHCP-Modus“ in der Software links im Fenster , Projekte*. . . ) ) — Dot Gerate-Konfiguration Gber die Schalt-
ecoExplorer go*. . _ _ ] 6. Wahlen Sie in der Auswahlliste ,,Verbin- i flach Ubert “oder . Ubert
3. W?hlen Sle unter Schrl?t 1 ,,Date/ty;? dungstyp“ > ,, TCP/IP“ und geben im Feld B [ e e (A [ af' en ,Ubertragen - oder,, Ubertragen
Beachten Sie, dass die Baudraten der wéhlen* in der Kategorie , Messgerate” den ,Host“ die IP-Adresse lhres Gerits ein. 8 Ss:ﬂi‘m:cssﬂ.e an”!
Gerite in der RS485/Busstruktur tiber- »Dateitypen” (Energy Analyser D550). Die IP-Adresse |hres Energy Analyser D550 B vrock cose . . ) )
einstimmen! 4. Klicken Sie auf die Schaltflache , Weiter®. bestimmen Sie tber die Adressen 300 bis 11. Wahlen Sie in der Auswahlliste , Verbin- G HINWEIS! , ,
- : . : . dungstyp“ > ,Ethernet-Gateway”, im Feld Diese Geréate-Konfiguration be-
303 im Programmier-Modus (siehe Betriebs- — o ; L .
: ot = »Adresse” die IP-Adresse lhres Master- schreibt Basis-Einstellungen. Weitere,
anleitung und Schnelleinstieg zum Geréat). A " : : s
; ; ; s Gerats (Energy Analyser D550) und als fur verschiedene Funktionen nétige
7. Klicken Sie auf die Schaltflache N . R A ) . o
Verbindungstest* Geréateadresse die eingestellte Geratead- Geréte-Einstellungen finden Sie in der
” ’ = e = e ) resse (Drehwahlschalter) am Energy Logger Bedienungsanleitung (online verfligbar)
= = D550 (1) ein. der Software. w = »x
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General information

This "Quick guide" does not replace the
operating manual. First, please read and ensure
that you understand the operating manual that
accompanies the product.

Disclaimer

The observance of the information products for
the devices is a prerequisite for safe operation
and to achieve the stipulated performance
characteristics and product characteristics.
Weidmliller Interface GmbH & Co. KG accepts
no liability for injuries to personnel, property
damage or financial losses arising due to

a failure to comply with the information
products.

Ensure that your information products are
accessible and legible.

Further documentation can be found on our
website www.weidmueller.de.

Copyright notice

© 2016 - Weidmidller Interface GmbH & Co.
KG - Detmold. All rights reserved. Duplication,
editing, distribution and any form of
exploitation, also as excerpts, is prohibited.

Subject to technical amendments

Note that this document may not always be
updated at the same time as technological
developments. Information and specifications
may change. Please check for the latest
version at www.weidmueller.de.

Disposal
Please observe national regulations!)
If disposing of individual parts, please do so
in accordance with their nature and existing
country-specific regulations, for example as:
e Electrical scrap
e Plastics
e Metals
Or, task a certified disposal business with the
scrapping.

Relevant laws, applied standards and
directives

The laws, standards and directives for the device
applied by Weidmdiller Interface GmbH & Co. KG
can be found in the declaration of conformity.

Safety

Safety information

The "Quick guide" does not represent a full
listing of all necessary safety measures required
for safe operation of the device.

Certain operating conditions may require
further measures. The "Quick guide" contains
information that you must observe for your

own personal safety and to avoid damage to
property.

Symbols used:

This symbol is used as an addition
to the safety instructions and
warns of an electrical hazard.

Indicates an immediately
threatening hazard that leads to

DANGER! serious or even fatal injuries.

situation that could lead to

2 Indicates a potentially hazardous
serious or even fatal injuries.

WARNING!

Indicates a potentially hazardous
situation that could lead to minor
CAUTION! injuries or damage to property.

ires for safety

This symbol is used as an addition
to the safety instructions and
warns of a potential hazard.

This symbol with the word NOTE!
describes:
e Procedures that do not entail
any danger of injury.
e Important information,
procedures or handling steps.

BB

Safety instructions are highlighted with
a warning triangle and shown as follows,
depending on the degree of hazard:

When operating electrical devices certain parts

of these devices inevitable carry dangerous

voltages. This could result in serious bodily

injury or damage to property if not handled

properly:

¢ Before establishing electrical connections
to the device, earth it at the ground wire
connection if there is one.

* Hazardous voltages may arise in all circuit
parts that are connected to the power supply.

e Even after disconnecting the power supply,
there may still be hazardous supply voltages
present in the device (capacitor storage).

e Do not operate equipment with current
transformer circuits when open.

e Do not exceed the threshold values stipulated
in the operating manual - even during testing
or commissioning.

e Observe the safety and warning information in
the documents that belong to the devices!

Qualified personnel

In order to avoid injuries to personnel and

property damage, only qualified personnel with

electrical training are permitted to work on the

devices with knowledge

e of the national regulations for accident
prevention

e of safety standards

¢ of installation, commissioning and operation
of the device.

Proper use
The device is
¢ intended for installation in switch cabinets
and small installation distributors (please
observe step 3 "Assembly").
¢ not intended for installation in vehicles!
The use of the device in mobile equipment
is considered to be non-standard
environmental conditions and is therefore
only permitted after separate agreement.
¢ not intended for installation in environments
with hazardous oils, acids, gases, vapours,
dusts, radiation, etc.

The prerequisites of faultless, safe operation
of this device are proper transport and proper
storage, set-up, installation, operation and
maintenance.

Brief description of device

The device
e is a data logger, as the basis for your energy
management.
e is designed for fixed installation (mounting
rails) in low voltage switchgear.
e records and saves meter values and process
data.

The captured data serves to enable
e Evaluation of energy consumption and
operating hours.
e Monitoring switching statuses and faults in
buildings and operations.

Assembly

The device is intended for weatherproof, fixed
installation in low-voltage switchgear (protection
class Il per IEC 60536).
e |t is assembled on a 35 mm mounting rail in
accordance with DIN 60715.
e |t can be installed in any mounting position.
e Forced ventilation is not required.

NOTE!

in the operating manual.

More detailed information on the device functions, data and installation can be found

Connections and control elements of the Energy Logger D550

Digital inputs group 2
Digital inputs group 1

12345686
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15 16 17 18 19 20 21222324

RS485 interface

DIP switch S1,
device termination

Rotary switch X10
Rotary switch X1

2 LEDs - device status
Ethernet interface

Energy Logger D550

2425520000 Battery compartment

¥ Power
A sipy

Hasar g2 A LAV

Digital inputs group 3
Digital outputs

Connection
Supply voltage

Service button S2

Thermistor input

Connecting the supply voltage

The supply voltage for the device is
implemented via a 2-pole plug-in terminal.

The supply voltage |

evel and frequency for your

device is specified on the rating plate.

Fig. Connection of the supply voltage  Fig. Connection of the supply
via an external mains supply.

voltage.

Circuit breaker

voltage range.
Before connectin

details on the

Circuit breaker T Fuse
L Fuse L
N N
A Danger of injury due to
electrical voltage!
WARNING!

Serious bodily injury or death can result from:
e Contact with bare or stripped live wires.

circuit breaker

for the user.

Damage to property due to
A disregard of the connection
conditions or impermissible
CAUTION!  overvoltage

Your device can be damaged or destroyed
by a failure to comply with the connection
conditions or by exceeding the permissible

voltage, please check:
e Voltage and frequency correspond to the

value stipulated in the operating manual
have been complied with!

¢ In building installations, the supply voltage
must be protected with a UL approved

¢ The isolation device
- must be installed near the device and
in a location that is easily accessible

- must be labelled to identify the

g the device to the supply

ratings plate! Threshold

/ afuse (6 A, char. B)!

DC connection variants

In order to parameterise all functions of the
device, you require a PC with the network
analysis software "ecoExplorer go" installed on
it (availability see front page).

Using the Modbus protocol, you can modify and
call up the data using the Modbus address list.
The Modbus address list can be found under
www.weidmueller.de.

In order to parameterise the device with the
software, connect your PC with the device via
the serial interface RS485, or via Ethernet.

The most common PC connection variants
between device and PC:

1 . PC Ethernet Energy Logger
[ } (crossover patch cable) D550

Direct connection of PC and Energy Logger D550 via Ethernet.

Energy Logger
D550

Ethernet

Connection of the Energy Meter D550
via an Energy Analyser D550 as gateway.

Ethernet

Energy Logger
D550

(gateway)

RS485 (" Energy Meter
D370

Modbus slave)

o

Energy Logger
D.

Energy Meter
D370
(Modbus slave)

(Modbus slave)

Connection of the Energy Logger Energy Meter
D550 with gateway function to the RS485 Mo d[b)ESZIave
PC via Ethernet.

In this connection variant, the

e Energy Logger D550 can forward on requests
(e.g. from the software) to a Modbus-Slave
device.

e Energy Logger D550 cannot independently
request Modbus-Slave devices itself!

RS485 mode:

Energy Logger D550 as gateway, address 3 = 1
(You can configure the address with the
"ecoExplorer go" software).

)
(@)
Ethernet
B
7
Y
[+
a

Energy Meter
D650

(Modbus slave)

Energy Analyser
Ethernet SEas

Modbus Master)

Connection of the Energy Logger

D550 as Modbus-Slave device.

In this connection variant

e Communication with the Energy Logger D550
takes place via Ethernet or the Modbus Master.

e The Energy Logger D550 cannot transfer
Ethernet requests to further Modbus-Slave
devices itself!

RS485 mode:

Energy Logger D550 as Slave, address 3 = 0 (you
can configure the address with the "ecoExplorer
go" software).

A Property damage due to incorrect network settings

Device address (RS485)

If multiple devices are connected with each other
via the RS485 interface (e.g. in a bus structure,
see section 9), the master device distinguishes
between the integrated devices on the basis of
the device address. Each device on a network is
therefore issued a different device address.

The device address of the Energy Logger D550
is configured via 2 rotary switches
X10 X1

e The setting range lies between 1 and 99.

® The device address 00 is reserved! Do not
assign for Modbus communication!

e The device address 99 is attained by setting
X10 =9 and X1 = 9 (highest setting value).

DIP switch S1, LED device status

DIP switch S1

Depending on the placement of the Energy
Logger D550 in a bus structure, it is possible to
activate the integrated bus termination resistor
via the DIP switch S1 (see step 9).

LED device status
2 LED lights beneath the RS485 interface
indicate the status of the device:

B W Both LEDs light up. The device is
performing the start process.

u After 15 seconds, the start procedure is
complete. The red LED goes out, the green
LED lights up and indicates "Device in
operation".

Device error.

B B |f both LEDs are still illuminated after
the start procedure is complete, the
initialisation process was interrupted.

Ethernet interface

The Ethernet network settings are to be

specified by the network administrator and set
accordingly on the Energy Logger D550 using the
"ecoExplorer go" software.

556  nS56
M-\
NWw o W
400 4090

Ethernet connection
with the PC/switch

LED Function

Lights up when a connection (link)
exists.

Lights up sporadically when network
activity occurs.

Yellow

Green

NOTE!

The Energy Logger D550 is factory-set
to the fixed IP address 10.10.10.200
(subnet mask 255.0.0.0, DHCP =
deactivated).

The dynamic IP address is configured
via a direct Ethernet connection with the
software (see step 14, 15 and 16).

Fixed IP address

In networks without a DHCP server, the network
address of the device must be set via Modbus
or the software.

BootP
¢ Allows for the automatic integration of the
device in an existing network.
¢ Does not have the scope of functions of DHCP.

DHCP mode

RS485 interface

The RS485 interface on the device
® is designed as a 2-pole plug contact.
e communicates via Modbus RTU protocol.

The user-friendly configuration of the device is
possible with the "ecoExplorer go" software.

RS485 bus structure

e In an RS485 bus structure (line), you connect
all devices in accordance with the Master-
Slave principle.

e One segment of an RS485 bus structure can
include up to 32 subscribers/devices.

® The cable is terminated with termination
resistors (120 Q, 0.25 W) at the beginning and
end of a bus structure. The device contains
a termination resistor, which can be activated
via DIP switch S1.

e With more than 32 subscribers, repeaters
(amplifiers) are used to connect bus segments.

e \/oltage must be present at devices with an
active termination resistor.

¢ Replacing a Slave device with a bus
connection that is either switched on or de-
energised can destabilise the bus structure.

e Devices without a bus connection can be
replaced without this having an effect on the
bus structure.

Fig.: Placement in the middle of a bus segment;
termination via DIP switch S1 deactivated (OFF).

: : ) : DHCP integrates the Energy Logger D550 .
Example Factory setting Perform a device update (firmware) via the s . ; o ; e Recommendation: Install the Master at the end
e Device inputs that are dangerous to touch. respective device. CAUTION! Device address 13 | Device address 1 software. Within an Ethernet network, each device has in an existing network with DHCP server of a bus segment. Fig.: Placement at the end of a bus structure;
Render your device free of voltage before ¢ Provide a fuse for the neutral conductor ' a unique TCP/IP address that can be set automatically. When started, the device pulls the « If the Master device is replaced with termination via DIP switch S1 activated (ON, 120 Q).
starting work! Check the system is free of if the neutral conductor terminal of the Gonnection of ihe Erergy Logger Incorrect network settings can cause faults in the IT network! 8%2)12 89*(0)12 8%2)12 8%2)12 manually or assigned by a DHCP server. IP address, the network mask and the gateway a termination resistor that is active, the bus
electrical energy! source is not grounded. Find out the network settings for your device from your network administrator. %65 3 (Vs B 23 Y3 3 [Va E 13 from the DHCP server. structure is out of operation.
Baud rate Digital inputs and outputs auxmarfféﬁ%ﬁ; SO0 pulse input/S0 pulse transducer Thermistor input
24V DC
Fig. Bus structure Configure a common Baud rate for devices in NOTE! Energy Logger D550 Digital outputs 242[?:—.205 Each digital input of the device is designed auxi”arff;ﬁgﬁ 24V DC The thermistor input on the device is
an RS485 bus structure. The user-friendly configuration of the Digital inputs 1-5 - - The device features 3 digital outputs that use a joint i 2 2 oonr External | 24V for the connection of an SO pulse transducer. dimensioned for a temperature sensor with a
digital inputs and outputs of the Energy earth: / / / / / éil i ﬁ' 3 A sy auxiliary voltage | AC/DC Energy Logger D550 - + resistance range of 400 Q to 4 kQ. Do not exceed
T The Baud rate for the Energy Logger D550 is Logger D550 takes place in the software. a3V + e The LEDs indicate the status of the outputs. ieirietoz  2zezsze  2szzr s2 A by - This requires an external auxiliary voltage with Digital inputs 1-5 the total resistance load (sensor + cable) of 4 kQ! Example: vl 25
\/ \/ configured via software or address 002 of the ﬂ%_/— If the LED lights up (red) then the output is set Energy Logger D550 an output voltage in the range of 20 - 27 V DC L6 | 3-line connection PT100 26
Modbus address list. Digital | S5 to active - irrespective of whether there is an DIEHE| @i i 1= and a resistor of 1.3 kOhm/1 W. T The device determines the temperature 27
S A S Digital inputs g 25 Input 5 onwards connection to this output. Digfitel @uifauiss 1€ e [ﬁ 5 measurement value once per second.
Address 002 Baud rat The device has 15 digital inputs. a0V e Digital output 1 can be configured to monitor the The S0 plug module P Digital Configure the sensor type and temperature ) o5
T A4 A4 Setting aud rate The digital inputs are divided into 3 groups, each Weidmiiller 35 e I:I“k B _ | temperature. It is connected with a comparator Fig. Connection - [21 ] (optional): >" : ZAN Input 5 offset with the software or via Modbus. Exgmple. ] %
Slave Slave Slave with 5 inputs: Digtal| S4 via the thermistor input. ] = Dig'ital/ ulse outouts Y Digital e enables simple and fast connection of SO 2-Ilne. connec't/‘on PT1.000
0 9.6 kbps * 5inputs share one joint earth respectively. . . . g e >|4 : 2~ Input 4 [ Z'9terp P h Output 1 DG pulse transducers. a3 _ (requires additional bridge) 27
_ _ 1 19.2 kbps e LEDs indicate the status of the inputs. If the / / / / / (Sl é 5 A sy The digital outputs: — @—[ e is for a group of 5 inputs with integrated - ]
. Speisung notwendig / power supply necessary - . . . AL SE AL LD QAN 3.9V . . - . . 7 Digital Weidmiiller 35 Energy Logger D550 a k 25
LED lights up (green) then a signal is present 4k L e can be switched via Modbus and the weekly X resistors. 7 N Input 4 Example:
T BusabschiuB eingeschaltet / bus terminator on 2 38.4 kbps at this input. - [ﬁ s3 f switch clock. = NOTE! ol D 1.3K1W . 2 LD 2_line connection KTY83 26
. : : . wqn Digital ) : - i > : Power
3 57.6 kbps * Aninput signal is present (signal "1") >V : 2N In;I)%ItaB e can display the results of comparators. e If you use digital outputs as pulse ZA Ej Digital DC a3 S[[[[] Sy é 2 (requires additional bridge) 27
- if a voltage of at least 18 V is flowing e require external auxiliary voltage. outputs then the residual ripple of the = Output 2 ] ﬂ—%{ LILHIZOSDED B EIERED  _EE7 &
4 115.2 kbps (factory setting) at a digital input (typically 4 mA at 24 V). w39V e can be used as pulse outputs. external auxiliary voltage (DC) must 123 | |: S P AN pigital
i i i i . s . ! ; X Input 3 When connecting the KTY83/84 sensor, correct
. ' e If the input voltage is <5 V DC, no input signal Example connection "Digital inputs of groups — P2 | ¢ switch AC and DC loads. not exceed max. 5% | 9 ’
Modbus address .004 is used to conflgure the is present (signal "0"). 1 and 2" >'/ Digital | S2 e are not short circuit-proof. « Digital outputs .are rllot short-circuit —] a0V polarity must be ensured! Connect the negative
number of stop bits where 0=1 stop bit (factory 4 ZAN Input 2 roof! Z A\ 3 Digital 4k K e connection (labelled with a black ring) to
setting) and 1=2 stop bits. NOTE! - proot: S| Output3 - Fig.: S0 plug-in modle — Digta terminal 25!
Data bits (8) and parity (none) are preset. For fault-free operation of the device: 4k - 9 = ZN Input 2
e Lay screened cable from a cable [ H S1 :(r)arncsc;lmz:zcr\gng SO pulse
length from 30 m. : VAN Input 1 Example DC connection of two relays Y a3 ) ) )
e Correct polarity of the supply at the digital outputs E—%szl o Fig.: PT1000 line connection
voltage for the digital inputs >|4 = ZN |n;?,ﬁ Pulse
(20 - 30 V DC) must be ensured. Example of the connection of external switch transducer
contacts S1 to S5 to digital inputs 1 to 5.

The most important technical data

Supply voltage

Installation overvoltage
category

300V CAT Il

Protection of the supply
voltage (fuse)

Fuse:
6 A, Char. B (per UL/IEC)

Nominal range

AC 20V -250V (45 - 65 Hz) or
DC 20V -300V

Power consumption

max. 4 VA/2 W

Digital inputs

15 digital inputs, semiconductor relays, not short-circuit proof.

Supply voltage

20V -30VDC
(SELV or PELV supply)

Input signal present

> 18 V DC (typical 4 mA at 24 V)

count frequency

(signal "1")

Input 5|”gn"al not present <5VDC
(signal "0")

Pulse input (S0), maximum 25 Hz

Pulse input "

per DIN EN 62053-31:1998
(IEC 62053-31:1998 Class B)

1) To operate the device in accordance with DIN EN 65053-31

(S0), a resistor (1.3 kQ/1
the input.

W) must be connected parallel to

Digital outputs
3 digital outputs, semicond

uctor relays, not short-circuit proof.

Supply voltage

20V -30VDC
(SELV or PELV supply)

Switching voltage

max. 60 V DC

Switching current

max. 50 mAeff DC

Pulse output
(energy pulses)

Max. 20 Hz

Pulse output

per DIN EN 62053-31:1998
(IEC 62053-31:1998 Class B)

Temperature measurement input, 1 input (3-wire measurement).

Update time

1 second

Connectable sensors

PT100, PT1000, KTY83, KTY84

Total burden
(sensor + cable)

max. 4kQ

(? NOTE!

Further technical data can be found in
the operating manual for the device.

Direct PC connection of the Energy Logger D550 via Ethernet (Windows 7)

A common way in which to integrate the Energy
Logger D550 in your PC network is direct
connection via the Ethernet interface.

NOTE!

Because the Energy Logger D550 is
supplied with a fixed IP address, and

in order to integrate it in your company
network/your PC, you require administrator]
rights for the following steps!

Fixed IP address of your Energy Logger
D550 (standard factory settings)

IP address 10.10.10.200
Subnet mask 255.0.0.0
DHCP deactivated

Set the IP address of your PC for the

connection with the Energy Logger D550:

1. Press the Windows key.

2. The "Start menu" appears.

3. Click on "Control panel" in the right menu
field.

4. The window "Adjust your computer's
settings" appears.

5. Click on "Network and sharing center".

6. The "Network and sharing center" window
appears.

S » Control Panel » All Control Panel tems » Network and Sharing Center

o -
Fig. MS Windows 7 - "Network and sharing center"
window

7. Click on "LAN connection" under the
internet heading.
8. The "LAN connection status" window

appears.
e =] 1
enera | MS-Windows 7 -
Cornection window
Pty wmerens ||| "Status of LAN
Media State Enabled connec I‘/O Yel "

Duration: 07:3%:35
Speed 1.0.Gbps

" Befais...

Actiity
o B s
a7
Bytes: wrsmoy | 1.079.328.839
[Fproperties [Fyoissble Diagnose

9. Click on the "Properties" button.
10. After entering the administrator data, the
"Properties of LAN connection" window

appears.
e == o
e | MS-Windows 7 -
Comnsct using window
& Intel(R) 82579LM Gigabt Network Connection "Oro, e rties of LAN
This cgnnection uses the folowing tems e connection"
% Cliert for Micrasoft Networks
45005 Packet Scheduler
2} File and Printer Sharing for Microsoft Networks

V] s int

wery Mapper 14O Driver
i Link-Layer Topology Discovery Responder

[ el ][ Unnstel | [ Propeties |

Descrption

Allows your compuier to access resources on a Microsaft
networ

11. Double-click on "Internet protocol version 4
(TCP/IPv4)" to open the window "Properties
of internet protocol version 4 (TCP/IPv4)".

o e A=) 1],
senerd MS-Windows 7 -
ik ik e s bl s window
for the appropriate IP settings. " .
N '‘Properties of
(©) Obtain an IP address automatically .
© Use the folowing T addrese: Internet protocol
o zeiw || versiona o
Default gateway: 1Pv- 4) "

Obtzain DNS server address automatically

© Use the following DNS server addresses:

Alternate DNS server:

[Cveldate settings upon exit
ok Cancel

12. Select the option "Use the following IP
address" and enter the fixed IP address
and subnet mask. Please note that the IP
address of the PC must differ from the
fixed IP address of the device in the 4th
number block (see figure above)!

13. Click on the "OK" button.

The Energy Logger D550 can now be configured
using the software installed on the PC!

"ecoExplorer go" software settings for direct PC connection via Ethernet

Install the "ecoExplorer go" software on your
computer and proceed as follows:

Create a new project:
1. Select "File" >
"New project". For existing projects, select
your project under "File" > "Open project".
2. The "New project" window appears.
3. Click the "Next" button under step 1 "Select
project".
4. Under step 2 "Project path", select the:
- "Project name".
- "Project path".
5. Click on the "Done" button.
6. Your project appears on the left in the
"Projects" window in the working area.

Enter the new device into the project:

1. Select "File" >
"New file".

2. The "New file" window appears.

3. Under step 1 "Select file type" in the
category "Data logger" select the "File type"
"Energy Logger D550".

4. Click on the "Next" button.

Newi x|
Steps Choose Fie Type
1 uosserieryoe Proect: [proect =
Q e
e Tpes:
]
f—
= [ e

5. The "Configure connection" step appears
in the window.

=
:
e 1
Neu Energy Logger D550 [Ethernet]
oeve s
o
© Modbus RTU (Ethemet encapsulated)

6. In the selection list "Connection Type" >
"Ethernet" click on the "Address" field and
enter the IP address of your device (fixed IP
address 10.10.10.200), and enter the value of
the rotary switch of the Energy Logger D550
in the "Device Address" field (in this case "1",
see step 7).

7. Click on the "Connection Test" button.

8. If the connection test is successful, the
"Display device information" window appears
with the serial number, hardware version and
firmware version.

Show device it
-

@ serislnumber  1400-0442
L
Hardware revision: 2

Firmware version: 146

9. Click on the "OK" button.

10. Exit the "Add new device to the project"
step by clicking on the "Done" button.

11. Configure your device (see following steps).

IP configuration of the Energy Logger D550 ("ecoExplorer go") via direct

PC connection

NOTE!

In order to integrate the Energy Logger
D550 in a network with DHCP server

and for automatic assignment of the

IP address, subnet mask and gateway,
change the IP configuration from "Fixed
IP Address" (standard setting) to "DHCP
Mode". To do so, first set a "PC direct
connection with Energy Logger D550
via Ethernet" and configure the "DHCP
Mode"!

Once you have connected the Energy Logger

D550 with your PC via Ethernet (see step 15) and

integrated it in the "ecoExplorer go" software:

1. Open the context menu for your device with

the right mouse button:
In the window "Projects" > "Your project"
> "Devices" > "By device type" > "Energy
Logger D550" > "Device x".

2. Click on the "Configuration" menu item in the
context menu.

AL NERLD
& |

S mssan e @]

3. The "Configuration [device x]" window appears
in the right half of the working area.

0o v o020

4. Inthe "Configuration" window under the

"IP configuration'
list "DHCP Mode

" menu, in the selection
" select > DHCP.

5. End the process by clicking on the
"Transfer" button.

Your Energy Logger D550 is now prepared for

automatic integration
server.

in a network with DHCP

PC connection of the Energy Logger D550 via Energy Analyser D550 as gateway

1. Configure your Energy Analyser D550 via
Ethernet cable on your PC as a "DHCP
Client" (device IP address is assigned
automatically, see operating manual and
quick guide to the device).

2. Connect your Energy Logger D550 via the
RS485 interface with the Energy Analyser
D550.

NOTE!

In order to integrate the Energy Logger
D550 in a network with DHCP server and
automatic assignment of the IP address,
subnet mask and gateway, change the

IP configuration from"Fixed IP Address"
(standard setting) to "DHCP Mode" in the
"ecoExplorer go" software.

Ensure that the Baud rates of the devices|

match up in the RS485/bus structure!

"ecoExplorer go" software
Install the software on your computer and
proceed as follows:
1. Open the software on your PC.
2. Select "File" >
"New project". For existing projects, select
your project under "File" > "Open project".
3. The "New project" window appears.
4. Click the "Next" button under step 1
"Select project".
5. Under step 2 "Project path", select the:
- "Project name".
- "Project path".
6. Click on the "Done" button.
7. Your project appears on the left in the
"Projects" window in the working area.

Add Energy Analyser D550 to the project:
1. Select "File" > "New file" in the menu bar.
2. The "New file" window appears.

New File X

Steps Choose File Type

1 Choose File Type. Project: [project
2
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3. Under step 1 "Select file type" in the
category "Measurement devices" select the
"File type" (Energy Analyser D550).

4. Click on the "Next" button.

5. The "Configure connection" step appears
in the window.

w Eneray Anelyse

Steps

1. Configure connection

ve [FEE] =

£A 0550 [TCP/P]

Host Sz

Time out milisec.] 5000

6. Select "Connection type" > "TCP/IP" in the
selection list and enter the IP address of
your device in the "Host" field.

The IP address of your Energy Analyser
D550 is determined via the addresses 300
to 303 in programming mode (see operating
manual and quick guide to the device).

7. Click on the "Connection Test" button.

8. If the connection test is successful, the
"Display device information" window
appears with the serial number, hardware
version and firmware version.

Serial number: 7200-5254

Hardware revision: 0008
Ethernet
Profibus

Firmware version: 4042 2014-10-13 08:46:00

9. Click on the "OK" button.
10. Exit the "Add new device to the project"
step by clicking on the "Done" button.

Add Energy Logger D550 to the project:

1.

Click in the project window on the plus symbol in
front of the "Devices" directory.

2. Click in the "Devices" directory on the plus symbol in
front of the "By device type" subdirectory.

3. The previously installed Energy Analyser D550
appears.

4. Right-click with the mouse on the subdirectory
"By device type".

5. Click on the "New" menu item in the context menu.

6. Click on the "Other" menu item in the sub-menu.

7. The "New file" window appears.

New| x|

Steps

Choose File Type

1. Choose File Type project: [project
P

Q Fier:

Categories: File Types:

Power Factor Controller
Meters and PQM devices

1. Energy Meter EM Series
1. Energy Meter ECS Series
Generic Madbus

Virtual Devices

Description:

<bock |[ Next> ]| Fien tielp

8. Under step 1 "Select file type" in the
category "Data logger" select the file type
"Energy Logger D550".

9. Click on the "Next" button.

10. The "Configure connection" step appears
in the window.

Configure connection

1. Configure connection

C: P [Eihernet gatenay eq. for devices over AS465) jr
Enrgy Logger D550 [Ethernet-Gateway (2.8, fir Gerdte an der R5485)]

Host. 102.168.3. 168

Part sz
Time out [mlisec.] 5,000}
Max. no. retries 3
modbus protocol

© Modbus-TCP

©) Modbus RTU (Ethernet encapsulatec)

8 Connection test

e [ ] ) ]

11. In the selection list "Connection type" >
"Ethernet gateway", in the field "Address",
set the IP address of your Master device
(Energy Analyser D550) and as the device
address apply the device address (rotary
switch) set on the Energy Logger D550 (1).

NOTE!

Please make sure that the device
addresses of the Master (Energy Analyser
D550) and Slave (Energy Logger D550)
differ from each other. The device address
of the Master (device ID of the Energy
Analyser D550) is configured in the
window "Configuration" > Menu "Serial
interface" in the software.

12. Click on the "Connection Test" button.

13. If the connection test is successful, the
"Display device information" window
appears with the serial number, hardware
version and firmware version.

Serial number: 1400-0442

Hardware revision: 2

Firmware version: 146

Lo ]

14. Click on the "OK" button.

15. Exit the "Add Energy Logger D550 to the
project" step by clicking on the "Done"
button.

16. You can now configure your device with the
software.

NOTE!

In order to avoid data loss, save your
device configuration changes with the
"Transfer" or "Transfer to" buttons!

@ NOTE!

This device configuration represents
the basic settings. Further details for
device settings required for different
functions can be found in the operating
manual (available online) for the
software.

Weidmiiller 3¢




